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Preface

Thank you for purchasing this Sokkia product. The materials available in this Manual (the “Manual”) have been
prepared by Topcon Positioning Systems, Inc. ("TPS") for owners of Sokkia products, and are designed to assist
owners with the use of the receiver and its use is subject to these terms and conditions (the “Terms and
Conditions”).

@ Please read the terms and conditions carefully.

Terms and Conditions

Preface

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of
the product and implement the types of safety procedures recommended by the local government protection
agency for both private use and commercial job sites.

Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights
are reserved. Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute,
or allow any third party access to, any graphics, content, information or data in this Manual without TPS’ express
written consent and may only use such information for the care and operation of the receiver. The information
and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work,
time and money, and are the result of original selection, coordination and arrangement by TPS.

Trademarks

Magnet®, Sokkia®, and Topcon® are trademarks or registered trademarks of the Topcon group of companies.

Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned
by Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other
product and company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS
MANUAL AND THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED
HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING,
PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE
NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE,
OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS,
INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE
RECEIVER.

P/N: 1006255-01 iv



Preface

License Agreement

Use of any computer programs or software supplied by TPS and Sokkia or downloaded from a Sokkia website
(the “Software”) in connection with the receiver constitutes acceptance of these Terms and Conditions in this
Manual and an agreement to abide by these Terms and Conditions. The user is granted a personal, non-
exclusive, non-transferable license to use such Software under the terms stated herein and in any case only with
a single receiver or single computer. You may not assign or transfer the Software or this license without the
express written consent of TPS. This license is effective until terminated. You may terminate the license at any
time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of
the Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the
receiver. All ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If
these license terms are not acceptable, return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS' Confidential Information with a degree of care no less
stringent that the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing
in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be
necessary or appropriate to operate or care for the receiver. Such employees must also keep the Confidentiality
Information confidential. In the event you become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate
remedy.

Website; Other Statements

No statement contained at the TPS and Sokkia websites (or any other website) or in any other advertisements
or TPS literature or made by an employee or independent contractor of TPS modifies these Terms and Conditions
(including the Software license, warranty and limitation of liability).

Safety
Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The

receiver should only be repaired by authorized TPS warranty service centers. Users should review and heed the
safety warnings in an Appendix.

Miscellaneous
The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The

above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of
California, without reference to conflict of laws.

Specifications

The above Terms and Conditions may be amended, modified, suspended, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of
California, without reference to conflict of laws.

P/N: 1006255-01




Manual Conventions

This manual uses the following conventions:

Convention Description Example
Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click
Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.
Mono User supplied text or variable Type guest, and click Enter.
Ttalic Reference to another manual or help document | Refer to the 7opcon Reference Manual.

@@S
9,
\ 4

Preface

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system
performance, data integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of
warranty, or personal injury.

P/N: 1006255-01
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Introduction

The GNR5 is a multi-frequency, GNSS receiver built to be the most advanced and convenient network reference
receiver. The integrated receiver design includes a GNSS receiver board based on Vanguard™ technology, industry
leading Fence Antenna™, internal long-life batteries, memory storage, and optional cellular wireless
communication technology. The GNR5 delivers world-class positioning and navigation capability to your
application by tracking signals from multi-constellation satellite systems, including GPS, GLONASS, SBAS, BeiDou,
and Galileo.

The GNRS5 can receive and process multiple signal types (including the latest GPS L2C, L5, GLONASS C/A L2, and
GALILEO! signals) improving the accuracy and reliability of the solution, especially under difficult job-site
conditions.

Figure 1: GNR5 Receiver - Front

1. Contact Sokkia Support for detailed information about the supported GALILEO signals.
Introduction P/N: 1006255-01 1



Receiver Features

The following features combine to provide a positioning system efficient, secure, and appropriate for any survey
or application that requires highly-accurate timing and positioning solutions:

® 448 universal tracking channels

¢ Multipath reduction

¢ Adjustable phase locked loop (PLL) and delay lock loop (DLL) parameters

* 1PPS and event marker

¢ External oscillator input

* GNSS-disciplined internal crystal oscillator output

® RS232C and USB port connectivity

* USB storage device

* Removable memory

* Backup battery system

¢ Ethernet connectivity

* Web-based management

¢ Satellite Based Augmentation Systems (WAAS, EGNOS, etc.)

¢ Dual- or multi-frequency modes, including static, kinematic, real-time kinematic (RTK), and differential (DGPS)
survey modes.

* Ntrip server/client
¢ Multiple survey parameters, including multiple mask angles, static and dynamic modes, auto data logging, etc.

Unpacking Your Receiver Kit

=]
—+
=
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This section describes the documentation, standard kit components, and accessories (depending on your

purchase) that accompany your receiver. When you unpack your receiver kit, verify you received the items listed
in this section. Make sure the items do not appear damaged from shipment. If any of the items are missing or
damaged, contact your Sokkia dealer or Sokkia technical support. See “Getting Technical Support” on page 3.

Technical Documents

The GNR5 Operator’s Manual is designed to help you set up and use your new receiver quickly and efficiently.
You can download a digital copy of the GNR5 Operator’s Manual from the Sokkia Care Website at
https://us.sokkia.com/sokkia-care.

TopNET+ Operator’s Manual/— An on-screen help document that contains detailed information on how to
remotely configure your new receiver.

Sokkia Receiver Utility (SRU) Online Help- Help documentation for SRU is embedded in the software; See “Using
Sokkia Software With Your Receiver”.

Using Sokkia Software With Your Receiver

TopNET+ software is a full-suite of GNSS Reference Network management tools that builds on TopNET RTK by
adding Network RTK (model solution) to the available data services. It extends traditional RTK capabilities and
significantly improves initialization times when the Rover is a long distance from the nearest reference station.

The Sokkia Receiver Utility (SRU) is hardware configuration software for receivers and peripheral devices. You
can install it on personal computers and data controllers. You can download the SRU software from the Sokkia
Care Website (https://us.sokkia.com/sokkia-care). SRU Help is only available on the software.

Contact your Sokkia dealer for more information about the Sokkia software described above.

Receiver Features P/N: 1006255-01 2




Getting Technical Support

Before contacting a Sokkia customer representative about any problems with the receiver, see “Troubleshooting”
on page 36 for some solutions that may fix the issue.

Contact your local Sokkia dealer or visit the Sokkia Care Website (https://us.sokkia.com/sokkia-care) for
technical support.

3
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@g For quick and effective support, provide a detailed description of the problem.

When contacting Sokkia for technical assistance, provide the following information for better and faster service:

1. A description of the following:
— Field operation that was being performed when the problem occurred
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the
problem
— Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in SRU,
select Save to File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory
and storage capacity, etc.

4. Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Website

The Sokkia website provides current information about Sokkia’s line of products. The support area of the website
provides access to Sokkia field and office software, manuals, frequently asked questions, and so forth. To access
the Sokkia website, visit www.sokkia.com.

The Sokkia’s support website also provides complete support, such as news, updates, reminders, training, live
webinars, and customer service to help you get the information you need. Visit www.sokkiasupport.com.

Getting Technical Support P/N: 1006255-01 3




Getting Acquainted

The GNRS5 receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, internal batteries,
memory storage, and wireless communication devices. A flexible user interface enables you to connect the
receiver with various external devices, such as computers, network devices, sensors, frequency sources, etc.

Receiver Housing Overview

The receiver’s standard hardware configuration includes:

three serial data ports ¢ an external GNSS antenna port
a USB device and USB host ports ¢ a frequency input/output port
an Ethernet port * a 1PPS port

an interface for controlling and viewing data ¢ Event Marker port

logging, link, and power status e two internal batteries

an SD card slot o
a SIM card slot

two power ports

Although this is the standard configuration, the OAF must enable some of these features for proper operation.
See “About the OAF” on page 23 for details.

Front Panel View

Figure 2: Receiver — Front Panel View

Table 1. Font Panel Ports

¢ Serial Port A (7-Pin ODU-MINI-SNAP) — Used for communication between the receiver and an external
device.

¢ Mini USB — Used for high-speed data transfer and communication between the receiver and an external
device.

o LED Display Panel — For LED descriptions, see “Display Panel” on page 8.

Getting Acquainted P/N: 1006255-01 4



Table 1. Font Panel Ports
4 ¢ FN Button — Turns data recording on and off.
5 e Power Button — Turns the receiver on and off; puts the unit in Sleep mode.
6 ¢ SIM Card Slot — Resides on the front panel under the door and connects the SIM card to the receiver

board to provide cellular connectivity.

SD Card Slot — Resides on the front panel under the door and connects the SD card to the receiver board
to provide memory.
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Back Panel View

Figure 3: Receiver — Back Panel View

Table 2. Back Panel Ports

1 ¢ External Frequency Port (BNC Connector) — Used for an external frequency input or the receiver’s internal

frequency output.
¢ PPS Port (BNC Connector) — Used for generating one pulse per second signals with programmable

reference time, period, and offset. The pulse is synchronized to a specified reference time.

3 o Serial Ports (x3) — Used for communication between the receiver and an external device.
Ports A and B are RS-232. Port C is RS-422.

a ¢ USB Type A — Used for high-speed data transfer and communication between the receiver and an
external device.

5 e Power Ports (x2) — Connects the receiver to external power sources. PWR1 supplies power to receiver
and charges internal backup battery. PWR2 does not charge the batteries.

6 o Ethernet — Used to connect the receiver to a computer or network.

7 ¢ Event Marker Port (BNC Connector) — Used to input an event synchronized with a specified time
reference.

8 ¢ GNSS Antenna Port (Type N Connector) — Used for detecting GNSS signals.

Receiver Housing Overview P/N: 1006255-01 5




Cables and Power Supply

The GNR5 package includes standard communication and power cables. Table 3 lists these cables.
Table 3. Receiver Package Cables

Cable Description Cable lllustration

USB Cable

Connects the receiver to an external device
(controller or computer) for high-speed data
transfer and receiver configuration.

p/n 14-008081-01

This can also be purchased at any local
computer store, and must be high speed
certified.

Serial Cable

Connects the receiver to an external device
(controller or computer) for data transfer and
receiver configuration. Body of connector is
black.

p/n 14-008005-03

Null Modem Cable

Connects the receiver with an external device
(controller or computer) for data transfer and
receiver configuration.

p/n 14-008086-01

Can also be purchased at any local computer
store.
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Power Cable
Connects the power supply unit to a grounded
outlet.

U.S. p/n 1005793-01
Europe p/n 1005794-01

Power Supply Unit

Converts the alternating current (AC) supplied
from an electrical outlet to a direct current
(DC) for powering the receiver.

The unit connects to the receiver via the
receiver power cable (see the power related
sections in “Using External Power Sources” on
page 12).

p/n 1005555-01

Receiver Power Cable

Connects the receiver and the power supply
unit via SAE connectors. Body of connector is
red.

p/n 14-008016-04LF

Fused Pigtail Cable

Connects the receiver power cable via SAE
connectors with a custom power supply unit
via bare wires.

p/n 14-008099-01

Cables and Power Supply P/N: 1006255-01 6




SD Card (Memory)

The receiver is equipped with a removable memory SD card that provides up to 32 GB of data storage. As data
is logged to the memory card, the REC LED displays the memory capacity status. See “Recording LED"” on
page 10 for more information.

Insert the SD Card into the SD card slot located on the front panel under the door. Once installed, the SD card
usually remains inside the receiver. You can access the data that resides on the card using the serial, USB,
Ethernet ports, or the Vanguard web interface.

Installing the SD Card
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<//\>€S To preserve data integrity, only install or remove the card when the receiver is powered off.

1. Make sure the receiver is turned off.
Make sure the card has been formatted for the FAT32 file system before first use. See “Formatting the SD
Card".

3. On the front panel, open the door by turning the two screws to the left.

Carefully insert the SD card, label side up, into the card.

5. Make sure the bottom of the card is recessed before closing the receiver door.
Once the receiver is turned on, the receiver board detects the SD card and is ready for use.

Formatting the SD Card

The GNRS5 requires an external SD card formatted for the FAT32 file system. You can format the SD card using
the internal disk management application provided by Microsoft; however, this application cannot create
partitions larger than 32 GB. You can also format the card with PC running Windows, and then use the card in
the receiver.

For more information about FAT32 limitations and formatting, got to
http://support.microsoft.com/kb/184006/en-us. For partitions larger than 32 GB, use external disk partition
software.

Formatting the SD card permanently erases all data on the card. Back up any necessary data before formatting
the SD card.

>

Internal Batteries
The GNR5 receiver was designed with internal, non-removable batteries, so there is no battery door or

connectors to worry about. These batteries, when fully are easily charged using the supplied power adapter or
an external power source. See “Internal Batteries” on page 13 for more information.

SD Card (Memory) P/N: 1006255-01 7




Display Panel

The GNRS5 receiver has a highly-visible display panel with single-button operation. The LED display panel enables
you to control receiver power and data recording. The LEDs display the status of the satellite tracking,
recording/memory capacity, wireless connections, and power. This chapter describes the different LED blink
patterns and what they mean.

Status Wi-Fi Cellular Power Function
(STAT) (CELL) (PWR)

N
\@9@&5
@

Power
Button

)

Recording
(REQ)

Bluetooth

BT) Battery

(BATT)
Communication
(RXTx)

Figure 4: LED Display Panel
Power Button
The power button performs multiple functions. The duration in which the button is pressed and held determines

how the receiver will perform. While pressing the button, the LED panel indicates the selected operation using
particular LEDs. Table 4 describes how to use the power button.

Table 4. Power Button Features

FUNCTION PRESS BUTTON LED DESCRIPTION

Power On 1+ seconds LEDs blink green until the startup is complete. LEDs return to
normal and the Power LED is solid green, indicating that the
receiver is on.

Power Off 3-10 seconds All LEDs are off. Release the Power button when the Power LED is
solid red. When no external power is present, the Power LED is
dark.

Clear NVRAM See “Resetting the Receiver (Clearing the NVRAM)" on page 29 for

more information.

Display Panel P/N: 1006255-01 8



Function Button o
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Table 5. Function Button Features )
o]
FUNCTION PRESS BUTTON LED DESCRIPTION g
RECEIVER IS OFF
Power Off Press button No action.
RECEIVER IS ON
Start/Stop Data 1-5 seconds e REC LED is green indicating data logging has started.
Logging « REC LED blinks green each time data is written to the receiver’s
memory.

e REC LED is red when receiver is out of memory, has a hardware
problem, of contains an improper OAF.

Toggle Post- Less than 1 second ¢ Press for less than 1 second when “Occupation mode switch”
Processing Mode has been enabled using SRU.

Change Information || Three times for less ¢ Press three times for less than 3 seconds when “LED blink mode
Mode than 3 seconds switch” has been enabled using SRU.

Change Baud Rate of || 5-8 seconds * After approximately 5 seconds, the REC LED becomes red.
Serial Port Release the Function button during the next 3 seconds.

Receiver Status LEDs

The status LEDs provide information about the battery life, tracked satellites, memory capacity, and wireless
connectivity. This section describes the color and behavior of each LED.

Tracking Status LED

The tracking status LED displays what type of satellite the receiver is tracking.
Table 6. Tracked Satellites

Color Description
Green GPS
Yellow GLONASS
Cyan Galileo
Blue SBAS/OMNI
Magenta BeiDou
White QZss

Function Button P/N: 1006255-01 9




Recording LED 9]
0
The memory LED indicates if data is being written to memory and displays how much memory the receiver has )
available for recording. <
Table 7. Recording LED Patterns g
Display Function Description g
o> Greater than 50% | File logging is in progress. Each blink indicates data is being =
o written to memory. When the receiver is in dynamic mode, the LED
&>  |Greaterthan 10% | bjinks twice every second. In static mode, the LED blinks once
@ > |lessthan 10% every second.
) Greater than 50% | The file is closed. A solid light indicates no data is being recorded.
Greater than 10%
) Less than 10%
Alternating green and red LEDs indicate all files are being deleted.
o e
Alternating red and yellow LEDs indicate the memory card is being
5y & initialized or formatted.

Missing or faulty The LED is off.
- memory

Communication LEDs

The communication LEDs display the status of the wireless activity. The following tables describe the
communication activity for four use cases: Bluetooth, Wi-Fi, Cellular, and UHF.

Bluetooth Only Status

Table 8. Bluetooth LED Patterns

LED Color Description
Bluetooth is on. Waiting for a connection.
o>
A single Bluetooth connection is established.
L
O Bluetooth is turned off.
Wi-Fi LED
Table 9. Wi-Fi LED Patterns
LED Color Description
The internal Wi-Fi modem is starting up.
- a3
The internal Wi-Fi modem is transmitting or receiving data.
o>

Receiver Status LEDs P/N: 1006255-01




Cellular Status! )
0
©
Table 10. Cellular LED Patterns g
LED Color Description g
The cellular modem is starting up. =)
L gup 0
o> The cellular modem is transmitting or receiving data.

Battery LED

The Battery LED indicates the remaining charge of the internal batteries. When an external power source is
utilized, the LED turns green and begins to blink if the batteries begin to charge. See Table 11 for more
information.

Table 11. Battery LED Patterns

LED Color ‘ Description

THE RECEIVER IS ON; INTERNAL BATTERIES IN USE
The charge is greater than 50 percent.

The charge is greater than 10 percent.

The charge is less than 10 percent.

THE RECEIVER IS ON; EXTERNAL POWER IN USE; PWR LED IS SOLID GREEN
An external power source is in use, and the internal batteries are fully charged.

The internal batteries are at greater than 50% capacity; the batteries are being
charged.

The internal batteries are at greater than 15% capacity; the batteries are being
charged.

The internal batteries are at less than 15% capacity; the batteries are being charged.

THE RECEIVER IS OFF

The receiver is connected to an external power source, and the batteries are fully
charged.

V08000

The receiver is connected to an external power source, and the batteries are being
charged.

Power LED

Table 12. Power LED Patterns

LED Color Description

An external power source is in use and connected to the PWR1 bulkhead. The LED
blinks green at 1 Hz intervals.

An external power source is in use and connected to the PWR2 bulkhead. The LED
blinks green at 2 Hz intervals.

An external power source is in use and connected to the PWR1 and PWR 2 bulkheads.

LED is dark when no external power source is connected.

0000

1. Cellular modem functionality will be added in a later version of firmware.

Receiver Status LEDs P/N: 1006255-01




Managing Power

This chapter describes how to power the receiver, charge the internal batteries, and use an external power source.
Turning On/Off the Receiver

To turn on the receiver, press and hold the power button until the LEDs briefly flash. When the receiver is turned
on, the receiver’s channels initialize and begin tracking all visible satellites at any time and location.

To turn off the receiver, press and hold the power button for more than three and less than 10 seconds (release
the power button when the POWER LED blinks yellow). Allow the receiver to complete the power off cycle
(approximately 30 seconds).

The receiver will draw a small amount of power from the batteries when it is turned off. If the
@@ receiver is placed in storage for a long period, such as a few months, the batteries may become fully
discharged. You will need to use an external power supply or recharge the batteries before use.

~ ,@ The Linux operating system will cause a brief delay in the powering on and off of the receiver. When
<//> powering off, the Power LED will briefly blink yellow before shutting down.

Using External Power Sources

The GNR5 receiver is designed to draw power from external power sources before drawing power from the internal
backup batteries.

You can connect the receiver to an external power source, such as a vehicle battery, with 9 V to 28 VDC to operate
the receiver. When setting up the receiver, consider the following powering requirements:

* Never use an extension cord for permanent power supply. This setup can create a fire hazard.
¢ Always use a grounded outlet.
* Use a surge protector to protect connected electronic devices.

See “General Details” on page 41 for more information on external power source requirements to power the
receiver and charge the internal batteries.

@ Power input greater than 28 VDC could damage the receiver.

Powering the Receiver

The receiver has two power ports. PWR2 will not charge the batters.
To power on the receiver:

1. Connect the power cable to the power supply unit.
2. Connect the SAE connectors on the power adapter cable and power supply unit.
3. Connect the power adapter cable to the PWR port on the receiver’s rear panel.

Managing Power P/N: 1006255-01 12



4. Plug the power supply into an available outlet.

(ooooo0)
N\ cooo //
)

SERIAL B

SERIAL €

(f\
\\\\ oo o@

Figure 5: Connect the Receiver to a Power Source

Checking Power Status

You can check the receiver’s power status using the PWR LEDs or available Sokkia software. The power LEDs
on the receiver indicate the following power status:

Solid Green — power within the acceptable range (628 V DC) is present on both PWR1 and PWR2 ports and
is being used to power the receiver.

Solid Red — either a power failure has occurred with a connected power source or the port is not receiving
power. For details, see “Insufficient Power” on page 14 and “Powering Problems” on page 36.

Green blinks — power within the acceptable range (6—-28 V DC) is present on this PWR port and is being used
to power the receiver and to charge the corresponding battery.

Red blinks — the corresponding backup battery is being charged.
Off — the receiver consumes power from internal backup batteries or the receiver is turned off.

Refer to the TopNET+ software manual for details on checking the power status via installed software.

Internal Batteries

The receiver first draws power from a connected external power source. When there is no valid external power
source connected or if the source has discharged lower than 6.5V, the receiver will draw its power from high-
capacity internal batteries (non-removable). Depending on the use case, the hours of operation provided by the
internal batteries vary.

Checking Power Status P/N: 1006255-01
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Charging the Backup Batteries

g
gz

N

Insufficient Power

g
gz

Charging the Backup Batteries P/N: 1006255-01 14

<\,>@ The backup batteries charge when the input voltage is between +9 and +28 V DC.

When the battery charge is low, the BAT LED changes from solid green to yellow and then red, depending on
the remaining charge (see “Battery LED” on page 11). When the receiver is connected to an external power
source, the batteries begin to charge whether the receiver is turned on or off.

To charge the batteries:

1. Connect the supplied power cable to the receiver’s power port.
2. Connect the power cable SAE connector to the SAE connector of the power adapter.

3. Plug the power adapter into an available outlet to fully charge the batteries. The batteries charge
simultaneously. You cannot over charge the batteries; the batteries stop charging when they are full.)
The BAT LED blinks as the batteries charge.

lanmod 3uiSeuepy

Use a grounded wall outlet or grounded surge protector while charging. The socket should be
located near the equipment and easily accessible.

If the batteries become fully discharged and an external power supply is not connected, the receiver will shut
down and automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for
the battery charge status. See “Battery LED"” on page 11 for more information.

If the receiver shuts down due to insufficient power, the receiver and all communication ports become
deactivated.

To restore power to your receiver and turn it back on:

* Recharge the batteries.
* Make sure the power/serial cable is correctly connected to the receiver’s port.

— Align the keyways when connecting the power/serial cable to the receiver port.

— Turn the cable lock clockwise until it clicks to secure the cable in place.

— To disconnect the cable, turn the lock counter-clockwise, and then gently remove the cable.
¢ Connect the receiver to a different power source.

Power supplied to the receiver should match the specifications provided by Sokkia on the product.
Failure to comply with these specifications may damage the receiver.



Configuring the Receiver

The GNRS5 receiver is intended primarily for use as a permanent or semi-permanent GNSS Reference Station to
establish networks supporting both real-time and post-processing applications. You can stream observation data
through any port to any device capable of receiving and utilizing it, including TopNET+ reference station software.
You can also log data internally to removable SD cards for downloading to support static or kinematic surveying,
mapping, monitoring, and positioning applications.

The GNRS5 is configurable for single to multiple scenarios, including the following:

* permanent and semi-permanent Reference Station
* temporary campaign receiver
¢ RTK or DGPS rover (for monitoring a fixed location, system monitoring, or mobile data collecting)

The sections in this chapter describe receiver configuration, receiver options, loading a new Option Authorization
File (OAF), updating firmware, and performing a factory reset. To do this, you will need to download the Sokkia
Receiver Utility (SRU) software from the Sokkia Care Website at https://us.sokkia.com/sokkia-care. For
information about installing the software, see the Sokkia Receiver Utility (SRU) Online Help, available only in the
software.

Configuring the Receiver

The GNRS5 is generally configured as a static Reference Station that collects GNSS measurement information and
logs the data to a removable SD card, streams the data to a central computer, and possibly connects directly to
one or more radios (or any combination of these configurations). The Sokkia Receiver Utility (SRU) and TopNET+
software are used to manage and configure the various functions of the receiver. Configuration settings are saved
to the NVRAM of the GNSS receiver board and are reflected when using the LED display panel.

The full range of both SRU and TopNET+ configuration and operation are outside the scope of this manual. For
more information on any of the procedures in this section, or on SRU or TopNET+, refer to the appropriate manual
available from www.sokkiasupport.com, or embedded in SRU.

Once you have established a connection between the receiver and the computer, you will be able to:

¢ configure the receiver and its components

¢ send commands to the receiver

¢ download files from the receiver’s memory

* |oad a new OAF and other configuration files to a receiver

Using the Web Interface

The GNR5 includes a built-in Web server that allows you to configure and monitor the receiver via a Web browser.
The following Web browsers are recommended for accessing the receiver:

* Windows Internet Explorer 6.0 or later

* Google Chrome

* Motzilla Firefox 2.0 or later

* Opera 9.0 or later

Accessing the Receiver Through the Web Browser

Before accessing the GNR5 using the Web browser, determine whether the valid network parameters (IP address,
gateway, etc.) are specified in the receiver. Refer to the SRU Online Help for details regarding the network
parameters.

1. Open a recommended Web browser.
The browser window appears.

2. In the Address or Location bar of the Web browser, type one of the following addresses:
http://ipaddress<:port number> or https.//ipaddress<:port number> (if SSL is enabled).

Configuring the Receiver P/N: 1006255-01 15



The jpaddressis the receiver’s IP address; port numberis the port number you should specify if set to a number
other than the default port number (port 80 for HTTP, and port 443 for HTTPS).

Once the information is entered, the main page displays.

Figure 6: Vanguard Web Interface — Main Page

When accessing the Web interface via SSL communications, a warning may appear stating the
@@ security certificate was issued by a company you have not chosen to trust. You can safely ignore this
warning and continue with the login procedure. Your communications will use SSL.

3. Enter the login name and password to access the Web interface.
The default login and password are admin. Login names and passwords are case sensitive, and can be up
to 12 alphanumeric characters.

USERNAME

PASSWORD

Figure 7: Vanguard Web Interface — Login

4. Click LOGIN.
After logging in to the Web interface, you can view and modify the receiver parameters.

You can access the receiver without entering the login name and password; however, you will be
= restricted to view-only activities.

Configuring the Receiver P/N: 1006255-01
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GNR5 Web Interface Ports

Although not necessary for functionality, you can configure the following ports to use with the GNR5 Web
interface.

* TCP 80 - HTTP

* TCP 8888 - web socket

e TCP21-FTP

* TCP 23 - Telnet

* TCP 8002 - GRIL port

If you are accessing the Web interface from behind a firewall or router, open and forward each port to the
receiver’s IP address.

Viewing Receiver Information

In the Sokkia Receiver Utility (SRU), the Receiver Info window displays basic Receiver information, such as
hardware and firmware versions, RAM size, receiver ID, serial number, etc.

To open the Receiver Info window:

1. Connect the receiver to a computer and open SRU.
2. In SRU, connect to the receiver.
3. Click Device » Application Mode » Receiver Managing.
4. Click Device » Connect.
5. In the Connection Parameters window, select the correct serial port, and click Connect.
6. In the SRU main window, click the Information icon. The Receiver Info window (Figure 8) appears.
=} Receiver Info ﬂ J g ﬂ
I MName Value
e Model GNRS
i Id W035M30T4I0
i@ Serial Mumber 1064-10630
8 Board Yersion B310_5
o GNSS Firmware Version 5.0 Mar, 25,2015 b20
¥ GNSS Hardware Version 0

¥ Power Board Firmware Version 300
¥ Power Board Hardware Version 5

¥ Linux Version unkniown
¥ Linux Build Time unknown
¥ Vendar Sokkia
8 Receiver Uptime 00:02:37
¥ CPU Freq., MHz 250
WERAM Size, KB 16,384

=IFlash Memory Capacity, KB 0.00
=IIFlash Memory Available, GB 7.39

=JIFlash Memaory Free, GB 7.33
Zpattery A, 8.34 (100%)
B Battery B, V 8.36 (100%)
ﬁPower Supply, V 12.00
ﬂPower Board, V 11,90
Save to File
. »

Figure 8: SRU — Receiver Info

Viewing Receiver Information P/N: 1006255-01
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Updating Firmware

Update Firmware Using SRU

The following describes how to update firmware on the GNR5 using a network connection. You can also update
the firmware using a Bluetooth, USB or a serial connection. To connect the receiver with a computer using a
USB connection, you will need to install a USB driver. USB drivers and firmware are available at
www.sokkiasupport.com.

Receiver board firmware is released as a compressed *.tar file uploaded using SRU, TopNET+, or FTP.

Connect to the Receiver

1. In SRU, click Device » Application Mode » Receiver Managing.
2. Click Device » Connect. The Connection Parameters screen appears.

3. Select Network from the Connect Using drop-down list, then click the dialog button from Device
Name (Figure 9). The Select Network Device screen appears.

Q)
©)
3
=
0q
c
=k
3
0q
-+
=y
)
A
¢}
0
o,
<
¢}
=

%, Connection Parameters

Connect Using

’Network - I

Device Name

(-]

b "

Figure 9: Connect to the Device Using Your Network
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4. Right-click in the Select Network Device screen, and click Add (Figure 10). The Network Connection @)
screen appears. g
F =
., Select Network Device 2o _| O x| OCQ
Friendly Mame IP Address or Host Name  Port =
3
< 10.1.30.68 8002 o
< 10.1.30.65 8002 —
CEPMVALGNRS 10.1,30.78 8002 =3
> 10.1.30.68 8002 ®
Y
¢}
0
] 2
Edit o)
Delete =
Refresh

Figure 10: Select Add to Add a Device

5. Enter the appropriate information for Friendly Name, IP Address or Host Name, TCP Port, and
Password, then click OK (Figure 11). The Select Network Device screen appears.

&9 Network Conne... 7| o« _ | O] x|

Friendly Mame

~

GMRS

IP Address or Host Mame

10.1.30.78

TCP Part

8002

Password

TPS

Figure 11: Enter the Information for the Device

6. Click OK on the Select Network Device screen. The Connection Parameters screen appears.
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7. Click Connect (Figure 12).
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Figure 12: Connect to the Device

Load the Firmware

1. In SRU, click File Explorer. The File Explorer screen appears.
2. Click the Files tab.

3. Right-click in the File Explorer screen, and click Open in Windows Explorer » SD Card (Figure 13). An
instance of Windows Explorer will open.

[ Pl Explorer ECEEET)

[ Logs | MINTER | AFRM | RINEX [ FTF Push | Fies |

Name Size, B Date
nulog0325 tps 1.401 461 3/25/2015 7:55:38 PM
log0325r tps 1,136,769 3/25/2015 5:55:38 PM
log0325s tps 574917 3/25/2015 6:34:44 PM
nulog0325s tps 625,164 3/25/2015 6:55:38 PM
nulog0325u tps 1,361,635 3/25/2015 8:55:44 PM
nulog0325v tps 1,528,507 3/25/20159:55:38 PM
nulog0325w tps 535,934 3/25/201510:33:33 PM
Refresh
Delete
Download
File: System Infa
i Open in Windows Explorer »
e USB Drive
Intemal Flash Drive
RINEX, Folder

Figure 13: Open the SD Card in Windows Explorer
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4. Open the b310.update folder in Windows Explorer, and delete any content in the folder (Figure 14).

= Recent Places

- -
1-_- - R ]
,.—-\ — i — — il e i
(_J\_J [ 1 » Thelntemet » 1013078 » a »
Organize =
: . T
+{ Favorites i b310.update GNRS upgrade
.Desk‘top " File folder File folder File folder
& Downloads =

- Libraries
@ Documents
J’ Music
|| Pictures
B videns
l b310.update on 10.1.30.78
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Figure 14: Delete the Contents from the b310.update folder

5. Open another instance of Windows Explorer and locate the appropriate *.tar file (Figure 15).

@_{' "‘gv| o v Thelnternet » 1013078 » a » b310.update

Organize =

. Favorites
Pl Desktop
4. Downloads

timage_gnra -b20-signed.tar

m

;
;= Recent Places

- Libraries
@ Docurments
JH Music
[ Pictures
B videns

E timage_netg5-b20-signed.tar on 10.1.30.78

-

Figure 15: Locate the Firmware File

6. Drag the *.tar file into the b310.update folder, and close both Windows Explorer windows.
7. Click OK in the SRU File Explorer screen. The SRU main screen appears.
8. Click Terminal. The Terminal screen appears.
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9. Enter % %set, update, yes in the command prompt, and click Send (Figure 16). @)
i | O
- Terminal 3_"
- 09
c
=
3
0)0]
-+
3
(0]
A
(0]
0
e,
<
(]
=
4 I
M Sendl E

Figure 16: Send the Update Command

During installation, the Power LED will blink yellow-green. After installation, the Power LED will be solid green.
Once the Power LED is solid green, close the Terminal screen and click Device » Disconnect in SRU.

Verify Firmware Upload

1. In SRU, click Device » Connect. The Connection Parameters screen appears.
2. Click Connect. The SRU main screen appears.

3. Click Information. The Receiver Info screen appears showing the current firmware loaded to the
device (Figure 17).

0 Receiver Info il 8 |3

I MName Value

i Model GNRS

w@rid W035M30T4I0

¥ Serial Mumber 1064-10630

@ Board Version B310_5

@ GNSS Firmware Version 5.0 Mar, 25,2015 b20

¥ GNS5 Hardware Version ]

@ Power Board Firmware Version 300
¥ Power Board Hardware Version 5

@ Linux Version unknown
w8 Linux Build Time unknown
@ Vendor Sokkia
W@ Receiver Uptime 00:02:37
#% CPU Freq., MHz 250
WHRAM Size, KB 16,384

=DFlash Memary Capacity, KB 0.00
=IFlash Memary Available, GB 7.39

(=IFlash Memary Free, GB 7.33
Bgattery A, v 8,34 (100%)
ZHlBattery B, V 8,36 (100%)
ﬂpower Supply, v 12.00
ﬂPower Board, V 11,90

Save to File

b T 4

Figure 17: Receiver Info Displays the Current Firmware
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Update Firmware Using an SD Card

Install Firmware Installation File

The following process can be done by removing the SD card from the receiver, or connecting to it using FTP,
SRU, or TopNet+.

1. Connect to the receiver or remove the SD card, and insert it into a computer.

Locate and open the b310 sub-folder on the SD card.

Verify that a b310.update folder is present. If not, create the folder.

Locate and copy your *.tar firmware installation file to the b310.update folder.

If you removed the SD card from the receiver in Step 1, insert the card into the receiver. Otherwise,
disconnect from the receiver.
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Begin Firmware Update

Open the GRIL terminal and send the command % %set, update, yes. The update will take up to 10 minutes to
complete. During installation, the Power LED will blink yellow-green. After installation, the Power LED will be

solid green. Once the Power LED is solid green, connect to the receiver using SRU and verify that the correct
firmware is installed (see “Verify Firmware Upload” on page 22).

About the OAF

Sokkia issues an Option Authorization File (OAF) to enable the specific options that you purchased. Sokkia’s OAF
system allows you to customize and configure the receiver according to your particular needs, therefore
purchasing only the options you require.

The GNRS5 receiver typically ships with an OAF as per initial purchase of the receiver kit configuration. There are
several upgrade options available with the receiver that can extend the receiver’s functionality to better suit your
job requirement. Examples of upgrade options are listed below:

¢ Standard Options

* GPS

* GLONASS

* GPS + GLONASS dual frequency static operation

* GALILEO

* BeiDou

* QZSS

* 50HZ

e 100HZ

¢ Additional external frequencies
Contact your Sokkia dealer or a representative for a complete listing of available options and pricing information.
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Checking the Receiver’'s OAF

To use SRU to view the status of the receiver’s options:
1. Connect the receiver to a computer and open SRU. See the Sokkia Receiver Utility (SRU) Online Help for

more information about connecting the receiver to a computer.

2. In SRU, connect to the receiver.

3. Click the Options icon in the main window. The Receiver Options window (Figure 18) displays, so
you can view the current authorization options and upload new ones.

=" Receiver Options

Friendly Name

[Elers
[ElcLonass
Gahleo
BeiDou
[ElsBas

|| Elazss
SateHita Tracking Channel Count
Dua\ Antenna Tracking
Co—op Tracking

| Quam Locked Loop
Adaptwe PLL

I Mult\path Reduction

[Eloeniss Mode
RTK Positioning, Hz
I RTK Vertical Accuracy Level, cm
RTK Horizontal Accuracy Level, cm
Maxlma\ Baseline Length, km
||| [E]Ho2 mode
[E]o1on mode
Autoseed Mode
DmniSTAR Service
Preclse Positioning Mode
[nertia\ Integration
Pos\tiun Update Rate, Hz

Memnry, MB
lfPFS Timing Signal
Evem Markers

Ser\al Port A Max Baud Rate
= .

Current
Tracking

L1, L2, L5

L1, 12, L3

E1, E5, E6

B1, B2

L1, L5

L1, L2, L3, LEX Tracking, LEX Decoding
224
Yes
Yes
Yes
Yes
Yes

Raw Measurement Update Rate, Hz 100

Positioning

o
No restrictions
Heading and Pitch
Yes
Yes
VBS, XP, HP, G2
Code, Float, Fixed, Veripos
Yes
100
Interfaces
No Restrictions
Double
Double
460,800

Permanent

72
No
No
No
No
No
0

No
Disabled
999

999
Disabled
Disabled
No

No
Disabled

No
0

i}

No

No
Disabled

Leased

L1, 12, L5
L1, L2, L3

E1, E5, E6

B1, B2

L1, LS

L1, L2, L5, LEX Tracking, LEX Decoding
224

Yes

Yes

Yes

Yes

Yes

100

Yes

100

0

1]

No restrictions
Heading, Pitch and Roll
Yes

Yes

VBS, XP, HP, G2
Code, Float, Fixed, Veripos
Yes

100

No Restrictions
Double

Double
921,600

Figure 18: Receiver Options

@g You can also check the receiver’s OAF using TopNET+ or the Vanguard web interface.

About the OAF
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Loading an OAF o
3
Sokkia dealers provide customers with OAF files. For any OAF related questions, e-mail Sokkia at o%"
options@sokkia.com and include the receiver’s ID and serial number. To obtain these numbers, see “Viewing c
Receiver Information” on page 17. g
To load a new OAF: o
(=
1. Follow the steps in “Checking the Receiver’s OAF” on page 24. I
2. Right-click on the Receiver Options window, and select Upload OAF.(see Figure 19). %
E‘Receivell)pﬁuns _?I;Iglél m
Friendly Name Current Permanent Leased ol 8
Tracking =0
[Elors <
[EleLonass (0)
Gal\leo -
Be\Dou
[Elseas
[E]azss |
SateHlte Tracking Channel Count 72 72 72 =
Dua\ Antenna Tracking No No No
CnropTrackmg No No No
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Figure 19: Right-click and Select Upload OAF

3. Navigate to the location of the new Option Authorization File.
4. Select the appropriate file, and click Open (Figure 20).
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Figure 20: Load OAF
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Sokkia’s SRU initially checks to see if the selected file is compatible with the currently connected receiver. If you
chose a file not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver
ID and disables the Upload the File to the Receiver button.

5. Click Upload the File to the Receiver to start loading the file (Figure 21).
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Figure 21: Upload the OAF to the Receiver

6. Click Yes at the prompt to reset the receiver (Figure 22).
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Figure 22: Reset Receiver

When the receiver resets, the Connection Parameters window opens.
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7. Click Connect (Figure 23). The SRU main window appears.
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Figure 23: Connect to the Receiver

8. Click Options (Figure 24). The Receiver Options window displays.
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Figure 24: Click Options
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In the Receiver Options window (Figure 25), ensure the following are correct:

* If you uploaded a universal OAF, make sure the expiration date is still valid.
¢ If you uploaded a customer OAF, make sure the correct customer file is loaded.
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Figure 25: Receiver Options Window

To view additional OAF details, right-click in the Receiver Options window and select View » Details

(Figure 26).
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Figure 26: Additional OAF Details
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Resetting the Receiver (Clearing the NVRAM)

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as
ephemeris data and receiver position. The NVRAM also keeps the current receiver’s settings, elevation masks,
recording interval, and information about the receiver’s internal file system. Clearing the receiver's NVRAM
resets the receiver and restores the factory default settings.

Although performing a “factory reset” of the receiver is not recommended as a common practice, there are times
when it can eliminate communication or tracking problems.

After performing a reset, the receiver requires time to collect new ephemerides and almanacs (around 15
minutes).

Resetting the receiver will not delete any files already recorded in the receiver's memory, and the NVRAM keeps
information about the receiver file system.

To clear the NVRAM:

Power off the receiver.

Press and hold the Function button.

Press and release the Power button for one second.

Verify that the Tracking Status LED is solid green.

When the Tracking Status LED blinks orange, release the Function button.

You can also use SRU to clear the NVRAM:

1. Connect the receiver to a computer, and open SRU. See the Sokkia Receiver Utility (SRU) Online Help for
more information about connecting the receiver to a computer.

2. In SRU, connect to the receiver.

3. Click the Tools icon in the main window.

The Tools window appears, enabling you to reset the receiver and clear the NVRAM.
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Figure 27: Tools Dialog Box

4. Click Factory Reset, and then click Yes to continue.
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System Setup

For a typical permanent or semi-permanent Reference Station setup, place the GNR5 receiver in a secure location
with access to power and communication links as required. Survey the antenna location very accurately, making
sure the receiver is free of signal obstructions and interference (RF, multipath, etc.).

As a temporary Reference Station, certain steps must be performed to ensure proper data collection. The following
steps detail the use of the GNR5 in a temporary Reference Station setup.

Before logging data, make sure the receiver contains current almanac and current ephemeris data.

Step 1: Setting Up the Receiver

1. Place the receiver in the predetermined location. A sturdy shelf or out-of-the-way table may be a convenient
spot.

2. For a permanent mount, drill four screws through the mounting location (shelf) and into the receiver’s
mounting holes.

3. Connect the power cable to an available and grounded outlet. See “Powering the Receiver” on page 12 for
more details and precautions.

4. Connect the antenna cable. If recording data to an external device, such as a USB hard drive, connect it to
the receiver using the required communication cable.

Figure 28: Mount Receiver and Connect Cables
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Step 2: Measure Antenna Height

The location of the antenna relative to the point being measured is very important for both surveys in which the
elevation of the point is important and in surveys for horizontal location only. Horizontal surveys are often larger
in area than can reliably fit on a flat plane; therefore, the antenna adjustment must be done in three dimensions
and then projected onto a two dimensional plane.

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the
station marker, the user must specify the following:

* Measured height of the antenna above the station marker

¢ Method of measuring the antenna height

* Model of the antenna used
Antennas have two types of measurements:

¢ \ertical — measured from the marker to the antenna reference point (ARP) located on the bottom of the

antenna at the base of the mounting threads.

¢ Slant — measured from the marker to the lower edge of the antenna slant height measure mark (SHMM).
The point to which all measurements are being referenced is called the Phase Center of the antenna. This is
analogous to the point at which a distance meter measures in a prism. A user must enter the prism offset to
compensate for this point not being at a physical surface of the prism. For a GNSS antenna, the offset is entered
depending on the type of measurement taken.

* For vertical, the offset is simply added to the measured vertical height to produce a “true” vertical height.

* For slant height, the vertical height must first be calculated using the radius of the antenna, then the offset
can be added.

The offsets are different because of the difference in location between the slant measuring point and the vertical

measuring point.

1. Measure the antenna height above the control point or marker, either the slant height or the vertical height
(Figure 29).

2. Record the antenna height, point name, and start time in the field notes.

The height of the antenna and its offsets depend on the type of antenna used. Refer to the antenna’s
documentation for details.

@@S Refer to the antenna’s offset measurements card for measurement and offset details.

1
1
1
! Reference Surface for
X Offset Measurements

Figure 29: Measure Antenna Height — Example
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Step 3: Collecting Data

See the remaining sections in this chapter for more information about collecting data.

1. Turn on the receiver. The STAT (status) light LED blinks red at first.

* Once the receiver has locked on to one or more satellites, the STAT LED will blink green for GPS satellites and
orange for GLONASS satellites. Other satellites will have different colors; see “Tracking Status LED" on page 9
for more information.

* Ashort red blink indicates that the receiver has not solved a position. Four or more satellites provide optimal
positioning.

* Once the short red blink is gone, the receiver has a position and surveying can begin; wait for green and
orange lights before beginning data collection. This ensures that the receiver has the correct date and time
and is locked on to enough satellites to ensure good quality data.

* The process of locking on to satellites normally takes less than one minute. In a new area or after resetting
the receiver, it may take several minutes.

2. Press and hold the FN key for 1-5 seconds to begin collecting data.

3. Release the FN key when the REC (recording) LED turns green. This indicates that a file has opened and
data collection has started. The REC LED blinks each time data is saved to the memory.

dnjas walsAg

<//\/>g To configure data logging, see “Display Panel” on page 8 or refer to the SRU Online Help.

Step 4: Stop Data Logging

Stop logging data when you need to move the receiver, download data, or perform maintenance functions.

1. Press and hold the FN key until the REC LED light goes out.

2. To turn off the receiver, press and hold the power button for more than three and less than 10 seconds
(release the power button when the POWER LED blinks yellow). Allow the receiver to complete the power
off cycle (approximately 30 seconds).

Static Surveying for Reference Stations

Static surveying is the classic survey method, well suited for all kinds of base station surveys. One receiver over
a survey marker collects raw data during a certain period of time. The length of the observation sessions can
vary from a few minutes to several hours. The optimal observation session length depends on the surveyor’s
experience as well as the following factors:

¢ the number of satellites in view

¢ the satellite geometry (DOP)

¢ the antenna’s location

* the ionospheric activity level

¢ the types of receivers used

* the accuracy requirements

* the baseline length
Generally, single-frequency receivers are used for baselines with lengths that do not exceed 15 kilometers (9.32
miles). For baselines of 15 kilometers or greater, use dual-frequency receivers.

Dual-frequency receivers have two major benefits. First, dual-frequency receivers can estimate and remove
almost all ionospheric effect from the code and carrier phase measurements, providing much greater accuracy
than single-frequency receivers over long baselines or during ionospheric storms. Secondly, dual-frequency
receivers need far less observation time to reach the desired accuracy requirement.

After the survey completes, data the receivers collect can be downloaded onto a computer and processed using
post-processing software (for example, Sokkia Tools).
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Analyzing Signal-to-Noise Ratio }é’
Knowing the strength and reliability of the ranging signal transmitted from the satellites will help determine the o
quality of the satellite signals. Use Table 13 to help estimate signal quality from a satellite vehicle. 3
Table 13. Typical SNR Values E
SV2 Elevation || C/A channel P1 channel P2 channel %
(degrees) (dB*Hz) (dB*Hz) (dB*Hz)

10-20 >35 >10 >10

2040 >40 >20 >20

40-60 >45 >30 >30

60-90 >50 >40 >40

a. SV = satellite vehicle

If the SNR value of a satellite signal is less than the threshold value from the table, then pay close attention to
this satellite because it can potentially cause problems for getting accurate timing and positioning results.

Collecting Almanacs and Ephemerides

Each satellite broadcasts a navigation message that includes the ephemeris parameters of the satellite, the
almanac, and various other information. The ephemeris parameters describe the orbital motion of the satellite
and are used to predict its location/trajectory. The almanac gives the approximate orbit (course) for the
transmitting satellite and all other satellites in the same system only.

* GPS and GLONASS satellites broadcast ephemeris data cyclically within 30 seconds.

* GPS satellites broadcast almanac data cyclically within 12.5 minutes; GLONASS satellites broadcast almanac
data cyclically within 2.5 minutes.

When the receiver has an almanac, you can considerably reduce the time needed to search for and lock onto
satellite signals.

The receiver regularly updates the almanac and ephemerides and stores the most recent versions in its Non-
Volatile Random Access Memory (NVRAM).

You need to collect or update the almanac and ephemerides under the following circumstances:

¢ If the receiver has been off for a long time.

¢ If the last known receiver position, stored in the NVRAM, is different from the present position by several
hundred kilometers.

* After loading a new OAF.

¢ After loading new firmware.

* After clearing the NVRAM.
To collect almanacs and ephemerides:
1. Set up the receiver.

The external antenna should be in a location with a clear view of the sky.
2. Turn on the receiver.

3. Wait for about 15 minutes while the receiver collects complete almanac and ephemeris data from the
satellites.

~ ,QS If 15 minutes have passed and the receiver does not lock onto satellites, then clear the NVRAM. See
<//> “Resetting the Receiver (Clearing the NVRAM)” on page 29 for details.

Analyzing Signal-to-Noise Ratio P/N: 1006255-01 33



This chapter provides general information about recording data, downloading it, and removing files to free up
internal memory.

Setting Recording Parameters

The Sokkia Receiver Utility (SRU) software enables you to set logging parameters, such as logging rate and types
of messages, in which to record data. See the SRU Online Help for more information. SRU Hejp is only available
in the software. Additionally, you can use TopNET+ or the Vanguard web Interface.

The GNRS5 is also compatible with any Sokkia field software for configuration and recording raw data.
Using the Vanguard Web Interface

The GNR5 includes a built-in Web server that allows you to configure and monitor the receiver via a Web browser.
the following Web browsers are recommended for accessing the receiver:

* Windows Internet Explorer 6.0 or later

* Google Chrome

* Motzilla Firefox 2.0 or later

* Opera 9.0 or later
The built-in Web server and

Logging Rates

The receiver provides up to 32 GB of file space on the internal (non-removable) memory card. The amount of
memory used to log data depends on the logging rate. For more information about setting logging rate
parameters, see the SRU Online Help, which is embedded in the software.

Recording Data

You can log raw GNSS data to the receiver’s internal memory and use the Sokkia Receiver Utility (SRU) or
TopNET+ software to download the files to a computer.

To start or stop recording data to the receiver, you can use the LED display panel or SRU:

1. Press the Power button to turn on the receiver.

2. Wait for the STAT LED to indicate satellites are being tracked. The STAT LED blinks green for GPS satellites
and amber for GLONASS satellites. A short red blink indicates the receiver has not solved a position. Five or
more satellites provide optimal positioning.

3. Press the Function button for one to five seconds to begin recording. You can also select File
Explorer » Logs » Start in SRU to begin recording data.

4. Make sure the REC light is blinking green. This indicates that a file has opened and data collection has
started. The REC LED blinks each time data is saved to the internal memory.

5. When you have finished recording, press the POWER button three times within two seconds, and make sure
the REC LED is dark. You can also select File Explorer » Logs » Stop in SRU to end data recording.

6. To turn off the receiver, press and hold the POWER button for 3 to 10 seconds until all LEDs turn dark and
the BAT LED is solid red.

<//\>€S You can also log data using MAGNET Field software.
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Managing Files

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the
receiver’s internal memory, and automatically given a name and a *.tps file extension. You can then transfer a
file of collected data to a computer with file managing software, such as the Sokkia Receiver Utility (SRU). This
program allows you to use an automatic naming feature, enter file names, and delete files as necessary. For
more information, see the SRU Online Help, which is available in the SRU software.

Downloading and Deleting Files

You can download data files to a computer or a controller for storage, post-processing, or backup. The memory
card holds a finite amount of files, so you will want to delete files to restore memory capacity.

When the memory card is full, the receiver stops logging data, and the REC LED turns dark/off, indicating an
error condition. Existing data is not overwritten, unless you have the AFRM mode enabled.

To delete raw data files from the receiver, use a USB, serial, Wi-Fi, or Bluetooth connection to download the files
to a computer. In SRU, you can select the files you want to delete from the receiver. See SRU Help, which is
embedded in the software.

Once a connection is established, you can download all or some files to a computer or controller and then use
the File Explorer feature in the Sokkia Receiver Utility (SRU) to manage the raw data files. For more information
about using SRU to download or delete files, see the Sokkia Receiver Utility (SRU) Online Help, which is available
in the software.

If you use the GNR5 as a reference station in a network, you can use TopNet+ or the Vanguard web interface
for downloading files.
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

' Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the
hardware.

Check This First!

Before contacting your local dealer or Sokkia technical support, check the following:

* Check all external receiver connections carefully to ensure correct and secure connections. Double check for
worn or defective cables.

® Check the receiver’s internal batteries for a full charge.

* Check the power source for incorrectly connected cables, and ensure the power source is valid. See
“Specifications” on page 41 for external power requirements.

* Check the software. Make sure the most current software version is downloaded onto the computer and the most
current firmware is loaded into the receiver. Check the Sokkia website for the latest updates.

* Check Sokkia technical support (www.sokkiasupport.com) for the latest updates.
Then, try the following:

* Power cycle off/on the receiver by pressing the Power button or by using SRU (Tools » Reset receiver).

* Restore default settings by pressing the Power button for 10 to 15 seconds or using SRU (Tools » Clear
NVRAM). This restores the receiver’s parameters to the factory default settings and erases the almanac and
ephemeris files. This action does not delete data files from the receiver memory.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

The receiver does not power up
* An external power source may be improperly connected.
— Make sure the power source is correctly connected.
— Make sure the power source contacts are clean and dust free.
* The power source may be discharged (if a battery is used) or may not provide enough power.
Connect/attach a fully charged battery or a correct power supply and retry. See “Powering the Receiver” on
page 12.
¢ If you are using an external power source, the cable may be disconnected or damaged.

Make sure the cable is securely connected and undamaged.
* The receiver may have a defective power source

Make sure the external power source is working properly.
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Receiver Problems

The following are some of the most commonly encountered receiver problems.

The receiver cannot establish a connection to a computer or external controller
Cable specific problems:
* The cable is not properly plugged in.
— Unplug the cable, then securely and properly reconnect it to the receiver.
* The cable is damaged.
— Use an undamaged cable. Contact a dealer to replace the cable.
* The USB driver is not installed.

— If you are using a USB cable connection, make sure the USB driver, included on the Software CD, is
installed on the computer. You can also download the driver from the Sokkia Care Website at
https://us.sokkia.com/sokkia-care.

Generic problems:
* The receiver port used for connection is not in Command mode.
a. Connect the receiver to a computer and open SRU (see the Sokkia Receiver Utility (SRU) Online
Help).
b. Click Receiver Settings » Ports.
¢. Change the Input Mode for the port used for connection to cmd.
* You can also use the Vanguard web interface to place the unit in Command mode.

The receiver does not lock on to satellites for a long period of time

* The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track
satellites).
— Order a new OAF with the desired options activated to enable or extend validity of the corresponding
receiver options. Contact a dealer or visit the Sokkia website for details.

— Refer to the Sokkia Receiver Utility (SRU) Online Help for a detailed description of options.

The receiver tracks too few satellites
* The survey is conducted near obstructions (tree canopy, tall buildings, and so forth).
— Make sure the Multipath Reduction boxes have been enabled.
a. Connect the receiver to a computer and open SRU (see the Sokkia Receiver Utility (SRU) Online
Help).
b. In SRU, connect to the receiver.

¢. On the SRU main window, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A
code multipath reduction check box is selected.
* Move to an area free of obstructions, if applicable.
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The receiver cannot obtain Code Differential and/or RTK solutions

* Incorrect Base coordinates entered.

— Specify the correct coordinates for the Base station using
SRU or another suitable field data collection software.

* The receiver is not configured as a Base or Rover.
* The corresponding receiver options may be disabled or expired.
— Order a new OAF with the required options activated to enable or extend validity of the corresponding
receiver options.
— Refer to the Sokkia Receiver Utility (SRU) Online Help for a detailed description of options.

* There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track
at least five common satellites.

— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on
the SRU main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
* A discrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:

a. Connect the receiver to a computer and open SRU (see the Sokkia Receiver Utility (SRU) Online
Help).
b. In SRU, connect to the receiver.
¢. On the SRU main window, choose Receiver Settings » Ports.
Double-click on the port to be configured and make sure the input mode of the Rover matches the
format of the Base output mode (i.e. RTCM3).
* Poor satellite geometry (PDOP/GDOP values are too high).
— Conduct the survey where satellite visibility is better (low PDOP value).
— Ensure the elevation mask is less than 15 degrees.
* The elevation mask is above 15 degrees.
— Lower the elevation mask. To do this, on the SRU main window, choose Receiver
Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
* There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).

=
e)
c
=
0
0
=
o)
0
=
3
0a

The receiver does not start logging data
* The receiver does not have a memory card installed or the memory option is disabled or expired.
— Make sure the memory option is enabled. For details, see the Sokkia Receiver Utility (SRU) Online
Help.
* The memory card does not have free space.
— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files”
on page 35.
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Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.

SRU error message: Can't find receiver

* The receiver is turned off.
— Ensure the receiver has power and is turned on.
Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.
* There is interference.
— Move the receiver, controller, or computer to an unobstructed location.
* The receiver is too far away.
— Move the devices closer together.
* The receiver is already connected via Bluetooth to another device.
— Disconnect the receiver from the other controller or computer.

SRU error message: Open COM# port failed: Access is denied
* Another application uses the computer port dedicated for connection.
— Close the application, and then re-connect.
— Connect the receiver via another, unused computer port.

After searching for available devices, none are discovered

* The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the power cable is correctly attached to the port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.

Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect to it
* Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.

* Bluetooth module settings may have changed.
a. If the settings are changed for the Bluetooth module, remove it from the list of discovered
Bluetooth devices using the Bluetooth manager program (supplied with the device used to
manage the receiver).

b. Repeat the search.
Cellular Problems

The receiver’s integrated cellular modem does not send and receive data

* Make sure the cellular antenna is properly connected to the receiver’s ANT port.

* Make sure you are within your cellular coverage with minimal obstructions. You may want to check the strength
of the cellular signals in your area using SRU. See the SRU Online Help embedded in the software.

Bluetooth Problems P/N: 1006255-01

=
s
=
o
®
w0
>
o
o
=d
5
da




SRU Problems

The following is the most commonly encountered SRU problem.

SRU cannot connect to the receiver

* The receiver is turned off.
— Ensure the receiver has power and is turned on.

¢ If using a cable, the cable’s connectors are improperly attached.
— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.

* If using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.

¢ If using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.
— Make sure the computer and receiver use the correct ports for communication.
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Cleaning and Storing the Receiver

* Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
* Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support

If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Sokkia Customer
Representative. For contact information, see “Getting Technical Support” on page 3.

SRU Problems P/N: 1006255-01




Specifications

This chapter provides specifications for the receiver and its internal components.

General Details

Table 14 lists the receiver’s general specifications.

Table 14. General Receiver Specifications

Physical
Enclosure Aluminum, IP67 rated extrusion
Color Sokkia Blue and Sokkia Grey

Dimensions (mm)

W: 150 mm x H: 60 mm x D: 200 mm

Weight (g) < 2.0 kg (with internal batteries)

Antenna External N connector

Status MINTER (8 LEDs + power button + function button)
display/panel

Serial/External
Power

Hirose H205-Series (6-pin, multiplex)
« Serial Ports A and B — RS-232
Serial Port C — RS5-422

2x Power — ODU 5

Ethernet — RJ45

USB Host — USB Type-A

¢ USB Device — Mini-B

usB

USB Mini B 2.0 (client)

External antenna
connector

N-Type connector

Bluetooth antenna

Fully integrated, high sensitivity

Tracking

Number of
Channels

452 channels Vanguard™ ASIC with patented Universal Tracking Channel Technology?®

Tracked Signals

GPS: L1 C/A, L1C, L1P(Y), L2P(Y), L2C. L5

GLONASS: L1 C/A, L1P, L2 C/A, L2P, L3C

GALILEO: GIOVE-A/B, E1b, Galileo E1, E5a, E5b, E6, AltBOC
BDS: B1, B2, B3 with ICD availability

QZSS: L1 C/A, L1C, L2C, L5, LEX

L-Band: 1525-1560 MHz (OmniSTAR and TerraStar)

SBAS: WAAS/EGNOS/MSAS

Multipath Yes, code and carrier

reduction

PLL/DLL setting Adjustable bandwidth and order
Smoothing Adjustable, code and carrier
interval

Specifications

P/N: 1006255-01
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Table 14. General Receiver Specifications

Data Output

RTK Corrections

TPS, RTCM SC104 v 2.x, 3.x; CMR/CMR+P

ASCII Output

NMEA 0183 version 2.x and 3.x

Measurement
data rate (max.)

20 Hz standard - Up to 100 Hz optional®

Data and Memory

Removable media

SD card

Internal memory

8 GB standard - Up to 32 GB

Message storage
rate (max.)

20 Hz standard - up to 100 Hz optional

Environment

Operating -20°C to +61°C (batteries)

temperature -40°C to +80°C (w/ external power on PW2/charging disabled on PWR1)
-20°C to +50°C (w/ external power on PW1/battery charging)

Storage -40°C to +70°C

temperature

Humidity 100%, condensing

Waterproof rating | IPX7 (1 meter submersion)

Dust rating IP6X (Fully dust proof)

Random vibration

MIL-STD 810G, Method 514.6, Broad band noise (random vibration), along each of 3 axes,
Category 4, table 514.6C-1V

Shock

MIL-STD 810G, Method 516.5. Table 516.5-1
Alternate Test Method of Classic Pulse; 40g, 11ms duration.

Technology

Sokkia Vanguard™ ASIC technology

Fence Antenna™ Technology

Sokkia advanced Multipath Rejection (AMR)
Integrity Monitoring (RAIM)

Sokkia Automatic File Rotation Mode (AFRM)
Universal Tracking Channels

Power

Internal Batteries

25 x 4P, 7.2v, 1200 mAh

Battery charging
time

<5 hours

Battery charging
method

Connect the AC adaptor to charge the internal batteries. Available run charge when
connected to an external battery. Charging of internal batteries when power input is greater
than 10 V.

External power
input

9 to 28 VDC (operating)?
28 to 80 VDC (over voltage protection)

External power
supply adapter
rating

Input: 100-240 VAC, 50-60 Hz, 0.8A
Output: +12VDC/2.5A (5A preferred)

General Details
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Table 14. General Receiver Specifications

Communication

Serial ODU-7: RS232, RX/TX, RTS/CTS
DB-9: RS232, RX/TX, RTS/CTS, RS232/RS422, RX/TX, RTS/CTS
USB 2 ports; USB Mini-B 2.0 (device) and USB Type-A (host)
Wi-Fi 802.11b Client/AP
Bluetooth v2.1 + EDR
Cellulare Yes. GSM/GPRS/EDGE/UMTS/3G/CDMA enabled
Ethernet RJ45

Survey Accuracy'

Static, fast-static

H: 3 mm + 0.1 ppm (x baseline distance)

(post-processed) | v: 3.5 mm + 0.4 ppm (x baseline distance)

Kinematic, RTK L1 +L2:
H: 8 mm + 1 ppm
V: 15 mm + 1 ppm

DGPS H: 0.4 m

V: 0.6 m
SBAS H: 1.0 m

V:15m
Cold start <40 sec.
Warm start <20 sec.
Reacquisition

<1 sec.
RTK Time-to- <20 sec.

First-Fix (TTFF)

a. Vanguard ASIC includes two dedicated channels for L-Band signal tracking. The GNRS5 receiver does not support L-
Band signal tracking.

b. CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and performance cannot be
guaranteed. Use of industry standard RTCM 3.x is always recommended for optimal performance.

¢. 100 Hz operation can be supported for custom applications. For more information, contact your dealer.

d. 9 to 28 VDC is the operating range of the external power source when the receiver is on. To turn the receiver on, the
power input must be between 8 to 30 VDC. To charge the internal batteries, the external power input must be greater
than 12 VDC.

e. Cellular modem functionality will be added in a later version of firmware.

f. Accuracy will vary depending on the number of satellites used, obstructions, satellite geometry (PDOP), occupation
time, multipath effects, and atmospheric conditions. Performance may be degraded in conditions with high Ionospheric
activity, extreme multipath, or under dense foliage. For maximum system accuracy, always follow best practices for
GNSS data collections.

General Details P/N: 1006255-01
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Safety Warnings

General Warnings

To comply with RF exposure requirements, maintain at least 25cm between the user and the receiver
when operating LongLINK technology.

angles and depths, and recording such measurements). This product should never be used:

' TPS receivers are designed for survey and survey related uses (that is, surveying coordinates, distances,

¢ Without the user thoroughly understanding this manual.
¢ After disabling safety systems or altering the product.

¢ With unauthorized accessories.

¢ Without proper safeguards at the survey site.

¢ Contrary to applicable laws, rules, and regulations.

Receiver Warnings
Tampering with the receiver by the end users or non-factory authorized technicians will void the
' receiver’s warranty:
® Do not attempt to open the receiver and modify any of its internal components.

® Do not charge in conditions different than specified.
® Do not short circuit.

Usage Warnings

If this product has been dropped, altered, transported or shipped without proper packaging, or
otherwise treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.

Inform TPS immediately if this product does not function properly.

Only allow authorized Sokkia warranty service centers to service or repair this product.
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Regulatory

The following sections provide information on this product’s compliance with government regulations for use.

FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the
FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of
RF energy that it deemed to comply without maximum permissive exposure evaluation (MPE). But it is desirable
that it should be installed and operated with at least 20cm and more between the radiator and person’s body
(excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part
15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

¢ Reorient or relocate the receiving antenna.

* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.

* Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following
two conditions: (1) this device may not cause interference, and (2) this device must accept any interference,
including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence.
L'exploitation est autorisée aux deux conditions suivantes : (1) 'appareil ne doit pas produire de brouillage, et (2)
I'utilisateur de I'appareil doit accepter tout brouilage radioélectrique subi, méme si le brouillage est susceptible
d’en compromettre le fonctionnement.

CAN ICES-3 (A)/NMB-3 (A)
Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European
Community.
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European Community Declaration of Conformity with R&TTE Directive
1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

e ETSI EN 301 489-1 V1.9.2 (2011-09)

e ETSI EN 301 489-3 V1.6.1 (2013-08)

e ETSI EN 301 489-7 V1.3.1 (2005-11)

e ETSI EN 301 489-17 V2.2.1 (2012-09)

e ETSI EN 301 489-24 V1.5.1 (2010-10)

e ETSI EN 301 908-1 V6.2.1 (2013-04)

e ETSI EN 301 908-2 V6.2.1 (2013-04)

e ETSI EN 300 328 V1.8.1 (2012-06)

e ETSIEN 301 511 v9.0.2 (2003-03)

e ETSI EN 300 400-2 V.1.4.1 (2010-08)

* EN 55022:2010/AC:2011

e EN 55024L2010

* EN: 62311:2008

* EN 60950-1:2006+A1:2010+AC:2011+A2:2013
The following CE mark is affixed to the device:

C€

@ This is a Class A product. In a domestic environment this product may cause radio interference in

A1ojen3ay

which case the user may be required to take adequate measures.

Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky (Sokkia) timto prohlasuje, ze tento (GNR5) je ve shod se

[Czech] zakladnimi pozadavky a dalSimi pisluSnymi ustanovenimi smrnice
1999/5/ES.

Dansk Undertegnede (Sokkia) erkleerer herved, at fglgende udstyr

[Danish] (GNR5) overholder de vaesentlige krav og gvrige relevante krav i

direktiv 1999/5/EF.

Deutsch Hiermit erklart (Sokkia) dass sich das Gerat (GNR5) in

[German] Ubereinstimmung mit den grundlegenden Anforderungen und den
ubrigen einschlagigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Eesti Ké&esolevaga kinnitab (Sokkia) seadme (GNR5) vastavust

[Estonian] direktiivi 1999/5/EU pdhinduetele ja nimetatud direktiivist
tulenevatele teistele asjakohastele satetele.

English Hereby, (Sokkia) declares that this (GNR5) is in compliance with
the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Espafiol Por medio de la presente (Sokkia) declara que el (GNR5) cumple
[Spanish] con los requisitos esenciales y cualesquiera otras disposiciones
aplicables o exigibles de la Directiva 1999/5/CE.
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[Greek]

Francais
[French]

Italiano
[Italian]

Latviski
[Latvian]

Lietuvi
[Lithuanian]

Nederlands
[Dutch]

Malti
[Maltese]

Magyar
[Hungarian]

Polski
[Polish]

Portugués
[Portugues]

Slovensko
[Slovenian]

Slovensy
[Slovak]

Suomi
[Finnish]

Svenska
[Swedish]

ME THN MAPOYZA ( Sokkia )

AHAQNEI OTI (GNR5 ) ZYMMOPOONETAL
MPOZ TIZ OYZIQAEIZ AMAITHZEIZ KAI TIZ AOINEZ
ZXETIKEZ AIATAZEIZ THZ OAHITAZ 1999/5/EK.

Par la présente (Sokkia) déclare que I'appareil (GNR5) est
conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

Con la presente (Sokkia) dichiara che questo (GNR5) & conforme
ai requisiti essenziali ed alle altre disposizioni pertinenti stabilite
dalla direttiva 1999/5/CE.

Ar 30 (Sokkia) deklar, ka (GNR5) atbilst Direktvas 1999/5/EK
btiskajm prasbm un citiem ar to saisttajiem noteikumiem.

Siuo (Sokkia) deklaruoja, kad 3is (GNR5) atitinka esminius
reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Hierbij verklaart (Sokkia) dat het toestel (GNR5) in
overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

Hawnhekk, (Sokkia) , jiddikjara li dan (GNR5) jikkonforma mal-
tiijiet essenzjali u ma provvedimenti orajn relevanti li hemm fid-
Dirrettiva 1999/5/EC.

Alulirott, (Sokkia) nyilatkozom, hogy a (GNR5) medfelel a
vonatkozo alapvetd kdvetelményeknek és az 1999/5/EC iranyelv
egyéb elbirasainak.

Niniejszym, (Sokkia) , deklaruj, e (GNR5) spenia wymagania
zasadnicze oraz stosowne postanowienia zawarte Dyrektywie
1999/5/EC.

(Sokkia) declara que este (GNR5) esta conforme com os
requisitos essenciais e outras disposi¢fes da Directiva 1999/5/CE.

(Sokkia) izjavlja, da je ta (GNR5) v skladu z bistvenimi zahtevami
in ostalimi relevantnimi doloili direktive 1999/5/ES.

(Sokkia) tymto vyhlasuje, ze (GNR5) spa zakladné poziadavky a
vSetky prislusné ustanovenia Smernice 1999/5/ES.

(Sokkia) vakuuttaa taten ettd (GNR5) tyyppinen laite on

direktiivin 1999/5/EY oleellisten vaatimusten ja sita koskevien
direktiivin muiden ehtojen mukainen.

Harmed intygar (Sokkia) att denna (GNR5) star |
overensstammelse med de véasentliga egenskapskrav och 6vriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1006255-01
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WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring
this product is disposed of correctly, to help prevent potential negative consequences for the environment and
human health, which could otherwise be caused by inappropriate waste handling of this product. For more
detailed information about the take-back and recycling of this product, please contact a supplier where you
purchased the product or consult.

A1ojen3ay

Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

* Baseband

* HCI

* Link Manager

* Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid
for any antenna with the same or less gain.

Korean KC-RF Compliance
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XY 2= (the number of channels): Bluetooth: 79 / Wi-Fi: 13
S5MH™E  (Antenna Power): 2.1 dBi
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I5EE (Product Id Code): MSIP-RMM-T8S-130400
SIS (Applicant): Sokkia
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Korean KC-Cellular Modem Compliance

This optional integrated cellular modem (PHS8-K) reference application complies with the requirements of the
Korean Communications Commission (KCC). The certificate granted in accordance with KCC has the identifier:

KCC-CRM-QIP-PHSS8K.
Japan Radio Law and Telecommunications Business Law Compliance

A1ojen3ay

Bluetooth and Wi-Fi Module Compliance

The integrated Bluetooth and Wi-Fi module TiWi-BLE reference application described on page 72 (General
Details - Communication) complies in accordance with the provisions of Article 38-24 paragraph 1 of Japan Radio
Law. The certificate granted in accordance with Japan Radio Law has the following:

Identifier: @ E 211-150204

Cellular Module Compliance

The optional integrated cellular modem (PHS8-J) reference application complies with the requirements of the
Japanese Telecommunications Business Law and Ordinance Concerning Conformity Certification of Specified
Radio as well as with the requirements of the Japanese “Radio Law” and “Ordinance Concerning Technical
Conditions Compliance Approval and Certification Type for terminal Equipment.”

The certificate granted in accordance with the Telecommunications Business Law has the identifier: AD 12-0011

202.
The certificate granted in accordance with the “Radio Law” has the identifier: 202-SMAQ14.
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Glossary

Glossary

BDS — BeiDou Navigation Satellite System maintained and operated by China. See also, BeiDou.

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for
nearby Rover (mobile) GNSS receivers.

BeiDou — Navigation Satellite System maintained and operated by China. See also, BDS.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over
short distances from fixed and mobile devices.

G

GALILEO - The satellite system currently being maintained and operated by the European Union (EU) and
European Space Agency (ESA).

GGD - GPS + GLONASS Dual Frequency signal tracking.

GLONASS — The Global Navigation Satellite System maintained and operated by the Russian Federation.
GNSS — Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS — The Global Positioning System maintained and operated by the United States Department of Defense.
L

L1 — The primary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

L2 — The secondary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s
components and control receiver operations.

MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of
the MAGNET software system.

MINTER - The receiver’s Minimum Interface used to display and control data input and output.

Network RTK — Collects satellite observations from the reference stations within the network and sends RTK
corrections to the Rover.

0

Option Authorization File (OAF) — This enables the specific features that a customer purchases.

P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward,
with the phase of the signal being equal at any point on the sphere.

Pocket-3D — Field controller software by Topcon that supports both GNSS and TS.
P/N: 1006255-01 50



Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the
measurement quality without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.
Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems. SBAS
transmits differential corrections and messages for navigation satellites that are within sight of a network or
reference stations in a wide area, such as a continent.

Sokkia Receiver Utility (SRU) — Hardware configuration software for receivers and peripheral devices. SRU
is available from the Sokkia Care Website (https://us.sokkia.com/sokkia-care).

Static Survey — Typically uses a network or multiple baseline approach for positioning. This method provides
the highest accuracy and requires the longest observation times.

T

u

Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller, computer,
etc.

P/N: 1006255-01 51
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SOKKIA

Concems regarding this Sokkia product may be sent to Service and Repair Department,
Topcon Positioning Systems, Inc., 7400 National Drive, Livermore, California 94550

Specifications subject to change without notice. All rights reserved. 1006255-01, Revision B, 01/2017 © 2017 Topcon Corporation
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